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Introductory note

1. Introductory note

This Manual has been drafted in order to familiarize users with the general manner of

conduct during on the road control and during control realized in company premises. New

users are recommended to start the TachoScan software and try out the operations as they

are presented, whereas, those users that command already some experience in working

with the software may, straight away, proceed to a given level of their choice.

Saying all this, the Manual is especially targeted to those persons, which had no previous

contact with read out of digital driver cards and of tachographs in the TachoScan software,

and thus, every single stage is meticulously portrayed. 

Usually, initial control assumes the following pattern:

· Logging in;

· New control "parameters" setting;

· Entering of data from tacho disco and/or driver cards;

· verification of tampering;

· Reporting and approval of offences;

· Control locking and exporting;

· Control unlocking and editing.

The Manual portrays the realization of all of these stages with the use of exemplary data.

Details of the drivers, controlled companies, driver card numbers and vehicle registration numbers are

fictitious.

2. New control

Expert license:

The nomenclature of "Expertise" instead of "Control"was introduced throughout the program.

Each control performed by TachoScan Control is recorded in the database, so when you

select New control you need to enter the data specifying: control no., date, name of the

controlled company and the type of control carried out.

To start a new control:

· in Control menu select New control;

or

· click on: , and then, in Controls menu window, select New control.
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The program displays: New control window which contains the following elements:
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New control parameters:

1. Number – the program automatically assigns a number for each control:

· the first part 0208 is the consecutive control number, which can be changed using

arrows on the right;
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· the second part 2014 is the current year read from the Windows system date;

· the third part 1234-1234 is the identification number of the logged inspector.

2. Date – this is the control date, by default the current date read from the Windows system

date is displayed.

3. Company name – enter the name of the controlled company or, for driver control, the

company he works for.

4. Cargo – in this window, select the type of carriage from the list: goods, passengers or

unspecified.

5. Controlled period: – select the period for which the inspection will be conducted.

Available options:

· 28 days

· 56 days

· a custom period defined by the user

By default, the program sets the controlled period to 56 days plus the current day if the

road inspection is scheduled from 31.12.2024 in the European Union and Switzerland.

For earlier dates or inspections outside the European Union, the default period is 28

days plus the current day.

Data downloaded from the driver card and digital tachograph outside of the specific range are NOT

analyzed and are NOT saved in the database.

If you change the "controlled period" you need to download again the driver card data and/or data

from the digital tachograph and re-analyze the drivers' infringements.

The period of infringements analysis may also be limited to the period of employment (see "Driver" ->

"Add" topic for more).

Immediately after downloading data from a driver card/ digital tachograph, in the daily

chart preview window, days outside the control period will be "grayed out" with an

appropriate message (see: fig. below).

6. Selecting the type of control:

· control on the premises:

Ř Carriage purpose – choose a purpose from the list: own purposes or earning.

Ř the control is divided into a driving time and rest periods control, and work time control - in

the Swedish language version

· roadside check:

Ř Driver name;

Ř Vehicle registration;

Ř Co-driver's last and first name – driving in a team;
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Ř Registration nation.

If data is retrieved from the driver card, this data is automatically filled in.

Ř Type of tachograph.

7. Mark all drivers data as confidential (in reports) - if this options is checked, all personal

data will be hidden on the reports.

8. Depending on the results of the checks carried out, fill in the following fields (data

entered in the fields below are displayed in the report: "Checks statistics for EU"):

· Lack of records for other work and/or availability;

· Driving and working time records;

· Recording equipment: incorrect functioning, misuse.

9. Time zone: – the local time offset against UTC - when you retrieve the data, the program

moves all times read from the driver card data and the tachograph against the time zone

set in this option.
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Fig. Daily driver chart (2:1 scale) - time shift.
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Fig. Weekly driver chart - time shift.

· Remember - the option allows to save the choice of the time zone. If the option is

enabled, the last saved time zone will be hinted while creating a new control. The

option is disabled by default.

By default Time zone: and Include daylight saving time option will be set based on the country selected

in the Registration nation field;

After downloading the digital data you can not change the time zone. The change is only possible after

the removal of all digital data of the current check. The simplest solution is to remove the current check

and to open a new one.

UTC (Coordinated Universal Time) - standard time determined based on TAI (French: Temps Atomique

International), taking into account the irregularity of the Earth's rotation and coordinated with the solar

time.

10. Average weekly working time  - Allows to set any dates for the

analysis to be carried out in the: Driver's average weekly working time report - detailed

report.

Fields marked with blue frames are required.

3. Entering of data

The TachoScan Control software makes possible the control of entrepreneur or driver,

who simultaneously uses vehicles carrying digital tachographs and analogue tachographs.

Then, the TachoScan software analyses all data and combines it appropriately.
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3.1. Scanning the record sheets

Record sheets can be scanned on two types of scanners: flatbed and roll scanner.

Default settings

The default settings make it easy to enter new record sheets in the program,

because the program can automatically fill in the appropriate fields with predetermined

values.

Default settings window is opened using:  icon.

Elements of the window:

1. Driver - Set the default driver.

When you select this option from the drop down list, you can select a driver that will

be displayed in the appropriate field in the record sheet view/edit window.

2. Vehicle - Set the default car

When you select this option from the drop down list, you can select a vehicle

registration number that will be displayed in the appropriate field in the record sheet

view/edit window.

Use the  button to add a new driver or a car to the database.

3. Date and time:

· Default disc date - the program will assign the date specified here to all scans;

· Start time - means the point of time from which a day (twenty-four hours) is

calculated by default on the disc.

Scanning settings

The "Program settings" window includes, among others, settings for the scanner. If

you select Show the settings option, scanning settings appear before every scanning. If

you use a scanner different than the one recommended by INELO Polska Sp. z o.o.,

scanning settings appear irrespectively of this option.

Recommended scanners: Canon LiDE 70, LiDE 100 or LiDE 200, Plustek SmartOffice

PS283.

Settings for other scanners:

Recommended scanner settings (Program settings window):

· resolution 300 dpi;

· brightness -20;
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· color – black – white;

· scanner lid background color: Black.

Brightness

Setting higher brightness can improve the quality of reading on dark discs. It

contributes to a clearer image. At the same time, additional points (distortions) having an

influence on the later analysis of the disc disappear. If some points are not recognized

by the program, you should add them manually on the tab "Read preview". If the reading

is still incorrect, you should try to set other brightness once again.

Fig. An example of a scanned kilometres graph.

3.1.1. Flatbed scanner

To start the scan process, place a certain number of discs (1 to 6) in the scanner so that

all are placed in the scanning area (A4 area). No special adapter is needed for proper

scanning. Discs can be arranged in any way.
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Red rectangles mark the disc sections considered in the analysis.

Discs on the scanner must be placed facing down. The example above shows the discs as seen from the

scanner glass side.

When you place a disc, close the scanner cover to limit the number of possible

inaccuracies. Scanning can be started in three ways:

· choose: "Get -> Scan" from menu: Data;

· click the  button on the toolbar;

· use the  shortcut.

After scanning, the program will open the last record sheet in the record sheet preview

edit tab, and the rest will be displayed in the Unsaved discs panel. Each record sheet should

be reviewed, data should be completed and saved.

For a detailed description of the record sheet preview/edit form refer to the topic: Analysis of scanned

discs.

3.1.2. Roll scanner

To start the scanning process, place a certain number of discs (max. 50) in the scanner

feeder, so that they are all directed with the graph to the inside of the scanner. The record

sheet discs should not be placed in the center of the scanner - they should, for ex-ample, be

moved to the right (fig. below). The angle of rotation of the disc teardrop is not important (fig.

below).

The scanner jamming after scanning half of the disk may result from placing it centrally in the scanner.
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Place the disc unsymmetrical fig. above and retry scanning.

When you place the disc in the tray, you can start scanning using the following

methods:

· choose: "Get -> Scan" from menu: Data;

· click the  button on the toolbar;

· use the  shortcut.

After scanning, the program will open the last record sheet in the record sheet preview

edit tab, and the rest will be displayed in the Unsaved discs panel. Each record sheet should

be reviewed, data should be completed and saved.

For a detailed description of the record sheet preview/edit form refer to the topic: Analysis of scanned

discs.

3.1.3. Set the record sheet start time

Start time is the time the driver first inserts the record sheet into the tachograph or the

start time of manual entries (on the back of the record sheet). It is represented by the purple

line from the centre of the disc. It can be changed on each tab containing a scanned image of

the disc (Read preview, Basic data).

Starting hour can be changed in two ways:

Using the option: "Change the time of starting"
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1. Move the mouse cursor to the place of the first insertion of the record sheet into the

tachograp (fig. above).

The clock in the upper left corner of the image shows the time over which the cursor is at this

moment.

2. Right-click in the same place and then select: Change the time of starting (fig.

above) from the drop-down menu.

3. Purple line (start time) will be moved to the selected location (fig. below).
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Exception:

If you select the start time place within a driving event, the program will automatically move it to the

beginning of the event.

Moving using the mouse

This method works only in the Basic data tab.

Moving is possible only within a single event on which the purple line is placed.
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1. Place the mouse cursor on the purple line, so that the arrow is changed into: .

2. Click and hold the left mouse button, then move the purple line to the desired

position.

3.1.4. Record sheet data

To save the record sheet it is required to specify the date, driver and vehicle.

To take full advantage of the program it is recommended to complete all the data:

Date

Enter the start date of the record sheet.

Driver and vehicle

These fields should be filled in using the drop-down lists besides. If the required

values are not included in the lists, use  buttons to complete the database. If the

default vehicle was set for the selected driver (add/ edit driver window), it will appear

automatically in Vehicle field, if it was empty.

Odometers

In Km initial and Km final fields enter the initial and the final reading of the odometer

of the vehicle (the numbers entered by the driver on the disc). Then in the Difference in

km box below, the difference of kilometres is shown, which is the distance travelled

according to the driver. If the calculated distance differs too much from the number of

kilometres read by the program from the disc, located in Sum of kilometers field, these

fields will be automatically highlighted in red.

Tolerance of km difference is in "Settings -> Analysis settings -> Tolerance tab" in the Alert if km

distinction greater than field.

In the Read preview tab, the program draws a thin red line to check whether the

kilometres reading was correct. If the red line does not coincide with the black one

drawn by the tachograph, re-scan the disc with other brightness settings or correct the

position of peaks manually.

Team disc

The Team disc field should be checked for discs from the drivers driving in a team.

Selecting this option results in a different analysis of the data in accordance with the
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respective regulations for drivers driving in a team.

3.1.5. Record sheet calibration

If you think that the program misread the start time of activity on the record sheet, check

if 12:00 o'clock is set correctly.

"12:00 o'clock" setting can be changed only in Basic data tab.

"12:00 o'clock" can be changed in two ways:

· right click anywhere on the record sheet image (fig. below), and then, from the drop-

down menu, select Advanced -> Set 12:00 hours.

· press .
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Colour markings are removed from the disk image and the red circle appears to mark the

position of the "12 o'clock" on the record sheet, the window showing the angle of deviation

of twelve o'clock and auxiliary lines indicating the hours on the disc (fig. below).

To change the position of "12:00 o'clock," click and hold the circle with the left mouse

button (fig. above), and then move the mouse to set the circle in the new position.

As you move it, the clock in the upper left corner of the image will be replaced by the number of degrees.
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Fine adjustment can be made by pressing the appropriate buttons (fig. above) in 12:00

A.M. angle window.

The correct setting of "12:00 o'clock" (always in the thinner end of the teardrop) is achieved if the

auxiliary lines coincide with the hours on the record sheet.

3.1.6. Manually add activities

The program allows you to add activities manually. You can use this option if the driver

during the inspection provided record sheet or printout from the tachograph, on which he

drew activities by hand (fig. below)
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To open the window of manual adding of the activities, choose one of the following

options:

· press the combination of  keys;
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· from the main menu Data select the Add manually option.

In the Manual adding discs, provide the following information:

1. Driver (fig. below);

2. Vehicle;

3. Date of starting the "record sheet/ day from the driver card";

4. Start time of the "record sheet/ day from the driver card";

Changing the day start time after adding the events is possible after their removal.

5. Click .

6. The final and initial number of kilometres;

7. Km difference - is calculated automatically;

8. Select the type of data presentation: analogue or digital;
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9. Alternatively, check the team field;

10. Annotations - here you can enter additional remarks;

11. Detailed data - events - contains a list of activities for the specific day, which should be

filled in:

· select the event type;

· time from - is automatically filled in based on the start time of the day, and in the

following items on the basis of the end of the previous event;

· time to - end time of the activity;

· km - for driving events you can enter the number of kilometres travelled;

· clicking  will add the event to the list.

The total duration of all events must be equal to 24 hours.

3.2. Download from driver card

To download driver card data, it is required to install and connect the digital card reader.

Retrieving data, after inserting a driver card to the reader, can be started in three ways:

· select: Get -> Scan from the Data menu;

· click the  button on the toolbar;

· use the  shortcut.

Subsequently, data analysis may proceed in two ways :

· Correct reading of data from the driver card/ tachograph;

· Corrupt reading of data from the driver card/ tachograph;

· Corrupt reading of data from the tachograph.

If you have downloaded the data from a driver card that is registered as canceled, the appropriate

information that such card was detected is displayed.

3.2.1. Preview and data edition

The top part of the edition window in digital discs contains the following elements:

Driver's daily chart

Basic data
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Driver, Date, Vehicle, start and end km counter status.

1. If on a given day, a driver rode more than one vehicle, you can shift between

activities connected with a given vehicle, choosing the appropriate registration

number in the Vehicle field.

2. Changes of date in the Day field causes a shift to the card of a chosen driver

from a given day, if it is in the database. Otherwise, instead of an activity graph,

the sign No data will appear.

3. Choosing a different surname in the Driver field causes the closing of data

edition of the previous driver and a move to data edition from the card of that

driver.

4. Arrows:   allow to move the chart by an hour back and forward. Moving the

chart even by an hour results in hiding of Overview column as well as initial and

final kilometers. This information is only available when we present the whole

day from the tachograph and in the tachograph's data there are saved initial and

final kilometers.

The choice of date or driver with the driver’s card has a completely different meaning than with

an analogical disc.

Activity marking

Fig. Graphical preview of the day from the driver card.

Other markings are described in the program legend window (  button

below the list of activities).

Special signs

 - inserting the card, with the country code;
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- removing the card, with the country code;

 - vehicle location marker, with country code (for smart tachograph readings).

The location for smart tachographs is checked every 3 hours of accumulated driving time,

when inserting and removing the card.

The card insertion marker will change color to blue if moved. 

Manual entry of a change of location without removing/inserting the driver card is not

properly recorded by some tachographs.

In such a case it may happen that the chart can show a few card removals in a row,

with the change of location, and similarly a few insertions in a row with the change of

location of the card.

Adding, editing, deleting entries of start and end countries

Adding:

1. Uncheck: editing blocked.

2. Right-click in the place of entering the country - select: Insert -> Place entry

from the drop down menu.

3. In the new window, select Country at the beginning or Country at the end, and

then select the country.

4. Click  - the program will insert a blue entry mark.

Editing:

1. Uncheck: editing blocked.

2. Click and hold the left mouse button on the entry mark and then move it to the

desired position (fig. below).
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Removing:

1. Uncheck: editing blocked.

2. Right-click on the country entry mark that you want to delete and then select:

Delete from the drop down menu.

Select an area

Select an area by placing two vertical brown lines on the chart (fig. below). In the

Selection tab, you can view the sum of the activities from the selected area. These

lines are placed by single-clicking the left mouse button in the selected place.

Fig. Selecting the area.

If the selection includes a driving event, the program will display a tool tip with the total

mileage and average speed (item 1 - fig. above).

Selection can be removed by right-clicking on the chart and selecting the menu

option: Remove selection line or Remove all selection lines (fig. below).

Fig. Removing the selection.

In the drop-down menu, there is the Bind the selection line to events' edges option

(fig. above) - if line is dragged near the beginning or end of an activity it allows to snap it

automatically to the beginning or end of the activity, respectively.

drop-down menu (editing enabled)

Available options (general):

· inserting a new activity;
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· change and deletion of highlighted activity;

· change of all activities card withdrawn for Stopover;

· setting an event as a team or non-team event;

· change of all activities card withdrawn lasting less than 5 minutes for

Stopover;

· marking a driving event as driving onto a ferry or train;

· inserting place entry;

· inserting OUT period in selected range or for the entire control ;

· inserting AETR period in selected range or for the entire control;

· deleting the vertical line of the highlighted area;

· deleting all things highlighted in the area;

· moving data from a digital tachograph in place of a Card Withdrawn (if a

preview of one of the tachograph slots is opened and the event card

withdrawn is chosen);

Each change can be reversed by pressing . Multiple pressing of this

combination will reverse a determined number of last changes.

Add, edit, and delete activities

The program allows you to add, move and delete activities downloaded from the

driver card.

If the following text is displayed: Select a vehicle so that you can edit data it means that on the

given day the driver has records for at least two vehicles. In such a case, the following changes occur

in the window:

- initial and final mileage counter is hidden;

- button: [Change vehicle] is blocked;

- in the list of activities, in summary, in the location window, in the events and failures window and in

the annotations window, records for all vehicles will be visible (if you specify a particular vehicle, in

these windows only records for this selected vehicle will be visible).

To unlock the above elements, choose a specific vehicle registration number in: Vehicle field.

Edit activity

When you hover the mouse over the border between two activities (the cursor
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changes onto the following: "  " - fig. below) press the left mouse button and

holding it (item 1) move the boundaries of the activity, and then release.

Fig. Moving activities.

To change the type of activity, right-click on the edited activity, then in the drop-

down menu select: Change to and select the type of activity.

If the driver does not change card withdrawn records in the tachograph, the options

useful in supplementing these activities are:

- "?" shorter than 5 minutes to a break;

- All "?" to a break.

Adding driving activities to the driver card based on detailed speed or instructions

registered on the tachograph

1. To add a driving event or other work event, right-click and select Insert

activities from the drop-down menu.

2. Please select at least one option.

· Insert driving / other work activity when the speed is registered while parking

in slot 1;

· Insert driving / other work activity when the instruction is registered in slot 2

while resting in slot 1;

3. In the Apply for: section, select the scope of the functionality:

· For the selected area;

· For the selected day;

· For the whole control (change only for the currently selected driver).

4. Confirm .

Add activity
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Select Insert from the drop-down menu, then select the type of event as well as

start and end time.

Delete activity

In order to delete an event, right-click on it and then, from the drop down menu,

select Delete.

The deleted activity is replaced with the activity following it.

When editing charts, the possibility to zoom them using the:  button on the right side of

the chart, is handy. Using the  button allows to zoom out the chart, and the  button

resets the chart to its default size.

The icons above are used to scale all the charts simultaneously.

If for the edited day we have a reading from the digital tachograph (the same vehicle), it is

possible to copy data from the tachograph instead the card withdrawn event ("? ") - option:

Copy events from tachograph - slot 1.

Options

Driving in a team

If in the edited day team activities occur and the program discovers data from a

second driver’s card for that day, the activity preview option of that driver is activated

– button . Pressing this button causes the appearance of a graph of the second

driver of the team, but non-editable. The option of moving to edition of a day of the

second driver of the team is also activated – button [Edit] below.

Preview of activities from the tachograph

If for a given day and vehicle the program discovers in the database data from a

digital tachograph, the option of event preview read from both tachograph slots of

that vehicle is activated – buttons  and . Pressing one of them will result

in displaying the activity chart for a given slot. The option of moving to edition of a
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day from a digital tachograph is also activated – button [Edit] below.

After hovering over the selected activity registered in the tachograph, a hint

containing in-formation about the driver and his / her card number will be displayed.

Speed chart

After clicking  below the activity chart, the following option is displayed: 

 Speed chart- show / hide the Speed chart downloaded from the tachograph.

The chart is displayed if speed data were collected for a given vehicle.

Dotted line indicates the authorized speed.

The program downloads and stores in the database the speed if Save detailed speed from

digital tachograph option is selected in the program settings window.

Digital tachograph records in its memory speed over the last 24 hours of driving.

There are warnings 

If this text is displayed in the bottom of the window, it means that the program has

detected irregularities associated with the use of the driver card in the open readout

- left-click on this text to display a list of irregularities: ("Manipulation warnings" tab

of "Infringements and manipulations" generation windows).

The analysis is based on the settings in the: Analysis settings window, "Warnings".

Button:

for a description refer to the section: "Weekly chart".

Button:

for a description refer to the section: "Printing activities".

Button:
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for a description refer to the section: "Print pictograms".

3.3. Downloading data from tachograph

TachoScan Control software includes tools that enable automatic data downloading from

digital tachograph using the following devices:

· DBOX;

· TachoDrive;

· Optac;

· DownloadKey;

· TachoReader Mobile II;

· TachoReader Combo Plus.

Installation, configuration and the data download routine for the above listed devices is

described in detail in the document: External devices – tutorial.pdf attached to the program

installation CD.

Below there is an additional description of how to use devices: TachoReader Mobile II

and Combo Plus.

3.3.1. TachoReader Basic

De gebruiksaanwijzing TR Basic bevat een beschrijving van de configuratie en het

downloadverloop m.b.t. gegevens van de tachograaf en de bestuurderskaart en zit in

elektronische vorm bij het toestelgeheugen.

De huidige gebruiksaanwijzing is beschikbaar (te downloaden) op onze website:

"https://tachoscancontrol.com/en/" in the: "Download -> Instructions".

Documentnaam: TachoReader Basic - tutorial (pdf).

3.3.2. TachoReader Combo Plus

TR Combo Plus manual containing a description of the configuration, procedure of data

download from tachograph and driver card is supplied in the electronic form in the device

memory.

The current manual is available (for download) on our website:

"https://tachoscancontrol.com/en/" in the: "Download -> Instructions".

Document name: TachoReader Combo Manual (pdf).

https://tachoscancontrol.com/en/
https://tachoscancontrol.com/en/
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3.4. Open from a file

To open, from a file, the scanned record sheet images or source files from the driver card

or the digital tachograph readings, you can proceed in the following ways:

· click on the:  icon located in the TachoScan tab in the toolbar;

· press the combination of  keys;

· from the Data main menu select Get -> Open from a file.

When you select this option, the normal file selection window appears. Please select the

file containing the desired record sheet (bmp format) or source file that contains the data

retrieved from the driver card or the digital tachograph (list of formats is specified below),

and then click .

Do not use this option to edit the record sheets which are already stored in the current control.

The next step depends on the type of file:

Record sheets (bmp)

The program opens "Record sheet view/ edit window" - each additional record sheet is

opened in a new tab.

Digital data (ddd, dtc, dtg, esm, c1b, v1b, tgd)

The program also opens files with digital data archived to formats: ZIP, 7z and ARZ.

Subsequently, data analysis may proceed in two ways :

· Correct reading of data from the driver card/ tachograph;

· Corrupt reading of data from the driver card/ tachograph;

· Corrupt reading of data from the tachograph.

If you have downloaded the data from a driver card that is registered as canceled, the appropriate

information that such card was detected is displayed.
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3.5. Correct reading of data from the driver card/ tachograph

If the downloaded data are correct, the new driver and vehicle are automatically saved in

the database.

1. Reading data from the driver card:

· All new cars are saved as inactive;

· If in the downloaded reading the program finds a driver that is stored in the database

with the status inactive, it will change their status to active;

· If in the downloaded reading the program finds a similar driver, it opens a window for

selecting/saving a new driver.

2. Reading data from the tachograph:

· All new drivers are saved as inactive;

· If in the downloaded reading the program finds a vehicle that is stored in the

database with the status inactive, it will change its status to active;

· If in the downloaded reading the program finds a similar vehicle, it opens a window

for selecting/saving a new vehicle.

Then Data summary window appears, consisting of two tabs:

1. Basic data - it contains, among others, card/ tachograph identification data, data on the

last control (driver card) and the date of the previous reading;

In the Number of days since previous download line, the following information is

provided:

· o number of "calendar days";

· o number of "days of recorded activity" - depending on the: Count only days with the

checked activities as the days of recorded activity: option selected ("Settings ->

Analysis settings" menu, "Analysis" tab)

2. Certificates - Analysis of the sections read

· for special files (S files), the Events and faults and Technical data rows are not

displayed;

· in the absence of a digital signature, the following annotation is displayed:

validdigital signature not required.

Clicking on:

·  - opens a digital signature print preview window;

·  - the program closes the window and goes to the preview of a day from the

driver card or the preview of the day from the tachograph.

The additional downloaded data is stored in a binary file in Digital subdirectory of the current control

directory. They can be opened from there and re-analyzed at any time by selecting "Data -> Get -> Open
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from a file" from the menu or by clicking on the  icon.

If the option Show lack of driver's records notification after new data has been read is

enabled in the program settings and, in the controlled period, the program finds no records,

the following window is displayed:

·  - the report generation window is displayed in a new tab;

·  - the report is skipped - the program proceeds to the next stage of

analysis;

Report on missing driver data can be generated during the control using the "Reports -> Lack of driver's

records".

3.6. Corrupt reading of data from the driver card/ tachograph

If the software detects a corrupt reading or invalid certificate, the following window will

be displayed:

 

 - properly read data is saved to the database - a further step is carried out in

the same manner as for a correct reading, except for:

· in the read summary window, reading/file will be displayed in red;

Ř in the Certificates tab the places where the program detected irregularities will be

indicated.

 - downloading data will be canceled.
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3.7. Import of data from tachograph to the card

Data

This mechanism makes it possible to fill the empty days, in which the driver does not

have any records of activities from the digital tachograph. You can import tasks assigned

to any driver, activities not assigned to any of the drivers and activities from a given

vehicle.

If the driver card is read later, the imported days are removed and replaced by the data read from the

card.

Data import mechanism can be run in several ways:

· from the "Data" menu select: Import of data from tachograph to the card;

· "click" the  button on the "toolbar";

· use the "shortcut" .

When you select one of the commands above, import window appears and should be

filled in as necessary:

· Driver - to which the data will be imported;

· Period - of the imported data;

· Hours range - whether to import all data or only for a certain range of hours;

· activities assigned to the driver - select the driver from whom data will be

imported, if the driver drove the vehicle using the driver card, but has not made it

available during the control;

or

· activities not assigned to any driver - select the vehicle from which data not

assigned to any driver will be imported, if the driver drove the vehicle without a

card;

or

· all activities from the specific vehicle - select a vehicle from which all data will

be imported (whether they are assigned to other drivers or not), if the driver

drove a vehicle without a card, using other cards, etc. 
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Days imported from tachograph are marked in the "List of discs/days from card" window ("Data ->

Driver card and record sheet data" menu) as Digital tachograph, while in "view/edit day on the

driver card window" above the driver's daily chart, TC symbol is displayed.

Place entries

Allows to supplement countries on the driver card with entries from the digital

tachograph, in the case of controls established in TachoScan Control version older than

4.0.9. For this purpose:

1. Select  the driver/drivers

2. Choose the period

3. Click .

Imported country entries are marked in the "preview/edit the day from the driver card window" with a

green line.

From version 4.0.9, when the complete set of data - from the driver card and

tachograph - is opened, the missing country entries from the tachograph are

automatically imported to the card.



38

Preview window of data from the digital tachograph

4. Preview window of data from the digital

tachograph

The window is divided into the following tabs: 

4.1. General and technical data

The tab is divided into several parts:

· Vehicle data;

· Range of stored days - two dates are visible in this part. The first date is the first day

with tachograph actions saved in the database, the second date is the last day with

tachograph actions saved in the database;

· Digital tachograph data/Smart tachograph data - this section includes tachograph

data;

Ř  - highlight with the mouse to see additional information;

Ř for smart tachograph, the "Registration nation" row remains empty

· Pairing sensors - this section includes data on the motion sensors;

Ř  - highlight with the mouse to see additional information;

Ř in the Sensor first pairing date field, you can choose a date form the list, which results in

changing the data in the two remaining fields;

· Identification of the coupled GNSS facility - this section includes data of

identification the GNSS facility;

· Calibration data - depending on the selected calibration date, this parts presents

data for the workshop which performed the calibration and the calibration itself;

· Seals - this section includes information on the way of Mounting and Identification

numbers of the used seals. There may be up to 5 seals;

Ř  - highlight with the mouse to see additional information;

· Analysis of the constant of recording equipment (k) and the effective

circumference of wheel tyres (l) -comparing and calculating the difference of "k" and

"l" constants for the selected calibration (Calibration data -> Select calibration)

against the previous one;

Ř Velocity - on the basis of the difference between "k" and "l" constants (see above) the

speed values for the selected calibration are compared with the previous calibration.

 There are warnings - if this text is displayed in the bottom of the window, it means that the

program has detected irregularities associated with the use of the tachograph in the open readout

- left-click on this text to display a list of detected irregularities ("Manipulation warnings" tab of

"Infringements and manipulations" generation window).

The analysis is based on the settings in the Analysis settings window, "Warnings" tab.
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Technical data in red - anomaly detected.

Type of detected irregularities in this tab (depending on settings):

- change in the vehicle identification number (VIN);

- change in the tire size for calibration;

- change in the characteristic coefficient of the vehicle (w) without changing the effective

circumference of tire (l);

- a significant change (over 3%) of the characteristic coefficient of the vehicle (w);

- a significant change (over 3%) of the recording equipment constant (k);

- incorrect authorized speed in calibration;

- period of 2 years from the last calibration exceeded;

- a high number of calibrations (more than two, except for the calibration carried out on the same

day) during two years;

- date of the first pairing is different from the date of the first calibration-activation.

 button - opens print preview of general information and technical data.

4.2. Activities on a specific day

This tab presents a list of all days saved on the tachograph card for the selected range of

dates. Each day can contain the following data:

· date and meter status at the end of the day;

· areas visited (the GNSS country is filled in only if read from a smart tachograph);

Ř moves you to the map view with selected GNSS location points (only for smart tachograph

reading);

· detailed information on card insertion and removal by the driver and the assistant;

· actions performed on the given day by the driver and the assistant;

Ř the following options are available, in addition to the option of removing the selection, in the

drop-down menu after clicking the RMB on the daily chart:

§ Copy all activities to driver's data;

§ Copy marked activities to driver's data;

After selecting one of the above options, the program opens a window where the driver is selected.

· list of actions with card insertions and removals for the driver and the assistant;

· list of actions from the card or the chart, if at least one card or chart is in the database

for the given day.

If it is a card, you can open "View/ edit a day from a driver card window" by clicking

[Edit];

The option: current vehicle only is selected by default. If the given driver moved in the given day

between vehicles and data from other vehicles was downloaded into the database (driver card download,

saving of the tachograph chart) then MARKING this option will cause that events for all vehicles driven by

him will be displayed.
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· Printout (24h) - a simulation of a printout from the tachograph;

· Speed chart - when this option is selected, below the activities chart an

interdependent speed chart is displayed;

The chart is displayed if speed data were collected for a given vehicle.

Dotted line indicates the authorized speed.

The program downloads and stores in the database the speed if Save detailed speed from digital

tachograph option is selected in the program settings window.

Digital tachograph records in its memory speed over the last 24 hours of driving.

Button:  - opens a print preview of the day from the tachograph.

Selecting an area

Select an area by placing two vertical brown lines on the chart (fig. below). In the

Selection tab (below the charts), in the Selected area field, depending on the selected chart

(Driver (slot 1), Co-driver (slot 2), Driver card), you can read the sum of the events from the

selected area. These lines are placed by single-clicking the left mouse button in the

selected place.

Fig. Selecting the area.

If the selection includes a driving event, the program will display a tooltip with the total mileage and

average speed (item 1 - fig. above).

Selection can be removed by right-clicking on the chart and selecting the menu option:

Remove selection line or Remove all selection lines (fig. below).

Fig. Removing the selection.

In the drop-down menu, there is the Bind the selection line to events' edges option (fig. above) - if line is
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dragged near the beginning or end of an activity it allows to snap it automatically to the beginning or end

of the activity, respectively.

4.3. Events and faults

This tab contains a general list of not permitted actions related with the tachograph or the

card or other problems with the device, as well as instances of exceeding permitted speed

downloaded from the tachograph.

Button:  opens the preview window for the events and failures printout - the

report is expanded in relation to the view by maximum speed data, average speed data and

other driver data, whose driver card was in the tachograph at the moment of the defect,

event or failure.

4.4. Activities, events and faults in the table

This tab presents data for events, failures, exceeding the speed limit, places visited and

card insertions and removals, all put into one table, which can be sorted in any way (by

clicking the header of the given column, another click causes the order to be reversed) and

filtered (filters are located on the right side of the window).

Button:  - opens the print preview window for speed limit violations

from the tachograph.

Button:  - opens the print preview window for actions, events and failures in

the table.

The contents of the columns Date, Duration and GNSS time are marked in red if a

difference is detected between the date and time of the GNSS position and the date and time

of the activity according to the tachograph and driver card. The contents of the columns

Date, Duration and GNSS time are marked in the same way in the Tachograph data report –

Activities, events and faults.

A warning about the difference between the date and time of the GNSS position and the date and time in

the tachograph/driver card is displayed depending on the activation status and the value of the setting

Warn when date and time of GNSS position differs from date and time in the tachograph or card by

at least [ ] minutes and the condition Show warning when there is at least [ ] minutes of driving

between time from GNSS and time in the tachograph.

The setting and condition are available from the menu: Settings -> Analysis settings -> Warnings.
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4.5. Card insertions and withdrawals

This tab features a list of driver card insertions and removals, which can be sorted and

filtered in any way. In comparison to the previous tab, the list also has information on the

country code and the slot number, from/to which the card was inserted/removed.

Button:  opens the print preview window for card insertion and removal.

4.6. Company locks and last download

This tab presents a list of company locks applied using the company card on the

tachograph. In the top part of the window, card data is displayed for the card using which the

last tachograph data download was completed.

Button:  opens the locks and last download print preview window.

4.7. List of controls

This tab displays all road checks recorded by the tachograph.

In addition, in Drivers on the day of the control column, the drivers who had activities

recorded on a tachograph on the control date are displayed.

Button:  - opens a print preview window of the controls displayed in the tab.

4.8. Speed profiles

Available only for data downloaded using special software (TachoReader Combo - option: "Special data

from VDO tachograph (S-file)") from Continental VDO tachographs (version 1.3 or later).

The tab shows the time periods in which a specific speed range of a vehicle was

registered.
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Fig. Speed profiles tab.

A message informing about the lack of data in the read section of speed profiles is displayed when the

speed registration function has not been configured in the tachograph being read. It is possible to

generate a report that does not contain data from this section.

Button:  - opens print preview of speed profiles information presented in this

tab.

4.9. RPM profiles

Available only for data downloaded using special software (TachoReader Combo - option: "Special data

from VDO tachograph (S-file)") from Continental VDO tachographs (version 1.3 or later).

The tab shows the time periods in which a specific engine rotational speed range was

registered.
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Fig. "RPM profiles" tab.

The rows in which the driving time according to RPM is higher than the driving time

calculated based on the activity are highlighted in red.

The RPM values in the columns (100, 234, 703, 937, etc.) may differ from the values presented in the

above figure. This depends on the calibration settings of the digital tachograph

A message informing about the lack of data in the read section of RPM profiles is displayed when the RPM

registration function has not been configured in the tachograph being read; It is possible to generate a

report that does not contain data from this section.

Button:  - opens print preview of RPM profiles information presented in this

tab.

4.10. Speed chart

The speed data read are shown on a graph in red, while acceleration is shown on the

graph in blue. Graphs can be freely scaled, moved, printed and saved.

Depending on the option below, the speed chart will be displayed in different colors:

·  Include daylight saving time (Option unchecked):

§ Speed according to Regulation 165/2014 - red;

§ Detailed speed 4/sec (so-called S-file) - green;

·  Include daylight saving time (Option checked):

§ Speed according to Regulation 165/2014:

- summer - light red;
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- winter - dark red;

§ Detailed speed 4/sec (so-called. S-file):

- summer - light green;

- winter - dark green;

Basic information

If the option save detailed speed data from digital tachograph is selected in the program

settings window, the list of speeds will be saved to the database.

You can set the required period that the chart will cover by default.

The blue color represents the acceleration and speed chart. The chart is generated

by the program.

The charts are visible only for the data that have been downloaded from the source

file (Open) or external devices, provided that the option of detailed speed data reading

was enabled during downloading the data from a tachograph.

Tachograph’s memory keeps the speed from the last 24 driving hours, registered with once per

second frequency.

By default, the program shows charts which cover full 24 hours of driving. You can

freely scale, displace, print, save etc. the chart with the tools located above it.

The toolbar comprises the following tools:

·  - expands the size of the chart by 10%,

·  - reduces the size of the chart by 10%,

·  - zooms the selected area,

·  - enables displacement of the chart,

·  - automatically resets the size of the chart to the default values in respect to

both axes,

·  - automatically resets the size of the chart to the default value in respect to

the horizontal axis only,

·  - automatically resets the size of the chart to the default value in respect to

the vertical axis only,

·  - allows to add a new checkpoint,
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·  - deletes a chosen checkpoint;

·  - possibility to save chart image to a bmp, jpg or png file,

·  - opens a chart print preview window,

·  - Statutory speed data - after expanding the

field you can select additional sections - available only for Continental VDO

tachographs, version 1.3 (since 2008), whose data were downloaded using

special software (see the following topic: "Continental VDO since version 1.3 -

Additional Sections" for a detailed description);

·  - decreases the value in the field described beneath,

·  - a check box to select the time range covered by the

displayed charts:

Ř whole range,

Ř last 1 minute,

Ř last 5 minutes,

Ř last 10 minutes,

Ř last 15 minutes,

Ř dates of the individual days covered by the range of the downloaded vehicle speed

data,

·  - increases the value in the field described above.

·  - If you enter the precise time (date and time)

in this field, the program will center the chart around the time and will broaden

the chart to 10-minute span.

(5 minutes before and 5 minutes after the entered time)

Continental VDO since version 1.3 - Additional Sections

For speed data downloaded from Continental VDO tachographs, version 1.3 and later,

using special software (TachoReader Combo - Special data from VDO tachograph (S-

file) option) click on the:  button for additional sections:

Despite the fact that this type of tachographs record speed over the previous 168 hours of driving

plus additional sections, during a standard download only statutory speed data (pursuant to

Regulation 3821/85) for the last 24 hours of driving are retrieved.

If the statutory speed (Regulation 3821/85) and speed over the previous 168 hours was downloaded

into the program, in the daily activity graphs from the driver card and/or digital tachograph the

statutory speed will be primarily displayed, and in its absence, the speed from the last 168 hours.

·  - speed history of the last 168 hours of driving
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recorded with a frequency of one second;

·  - Last three records (high resolution -

frequency: four values /second) of two-minute speed periods, in which there was

an unnatural speed change in a short period of time;

·  - Last three records (high resolution -

frequency: four values/second) of two-minute speed periods, in which there was

a sudden, high change in speed;

Additional options

Fig. The acceleration and speed chart window.

1. Show values on the chart - displays numerical values directly on the chart.

2. Show table - next to the speed chart, the program displays the speed in the form of

a table (see: blue background in the above figure).

· when hovering the mouse over a point on the speed graph, the value in the table

corresponding to this point will be marked;

3. Show checkpoints - the program will show checkpoints that have been already

added and it will also allow to add new ones:

· in order to add a new checkpoint, click  and then on a chosen place on a

speed chart;

· information displayed between checkpoints:

Ř traveled kilometers; 

Ř date and time;

Ř current speed;

Ř current acceleration/slowing down;

Ř minimal speed;
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Ř maximal speed;

Ř average speed.

4. Mileage chart - the program will display the number of traveled kilometers on the X-

axis of the chart and the 0 km/h speed will not be included on the chart;

· if the option is enabled, the options Speed chart and Acceleration chart will be

automatically disabled.

5. Authorized speed [km/h] - presented in the form of a line.

6. Lower limit of the chart - possibility of editing.

7. Upper limit of the chart - possibility of editing.

Fig. 2 shows two enlarged charts. You can precisely define acceleration or speed for

a given point in the chart. In order to do so, point out the required position with the

mouse – the program will display a box with the information pertaining to the position

(fig. below).

Fig. Enlarged speed and acceleration charts.

The Speed and Acceleration Report

There is a button to the window bottom right:  that can be used to save all

values recorded in the value diagram in the xls or csv file. The report will show as the

summary:
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Saving chart data into an "xls" file is possible on the computer with MS Excel installed.

· for speeds: maximum speed, average speed both in [km/h] and in [m/s],

· for acceleration: Max acceleration and Max deceleration,

· summary distance.

Before saving the file, the application will display the window of period length

selection (fig. below) – the period read from the current diagram view will be inserted by

default.

Fig. Preparation of the report.

5. Data verification

The next step after recording sheets/ days from the driver card or reading data from

digital tachographs is data verification and analysis of the drivers' tasks against the standards

of driving time, breaks and rest periods in accordance with the relevant legal provisions.

"Lack of driver's records" report displays the periods in which there are no records of

record sheet/ day from the driver card.

In the Infringements and manipulations" report, the program offers the ability to

automatically generate the places where there is a suspicion of tampering, as well as tools

for indirect analysis of the accuracy of stored data.

"Compare driving time and distance on the map" allows you to check whether the

distance travelled by the driver (or travel time) corresponds to the number of kilometres on

the map.

The last topic: "Presentation of infringements" contains the tools which allow you to

show the places where the infringements occurred and understand their reasons.

5.1. Lack of driver's records

The report Lack of driver's records displays the start and end time and duration of

periods during which the driver activities are not stored in the program activity.
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How to create a report

1. In the report generation window

· select driver/vehicle or check: All drivers/all vehicles.

· select "Period", from which data will be displayed;

· possibly for: Show lacks of data option, change the time value;

Options

Show lacks of data

longer than - lacks of data that last longer than time set in this option will be

displayed on the report;

shorter than - lacks of data that last shorter than time set in this option will be

displayed on the report.

Show manual rests

 longer than — on the report, the manual entries lasting longer than the time set for

this option will be displayed;

 shorter than — on the report, the manual entries lasting shorter than the time set

for this option will be displayed;

Only active for the driver.

To view the report, use the toolbar buttons (see: Generating reports).

5.2. Infringements and manipulations

Report based on collected data generates a list of infringements and interference

warnings. The report is generated for all drivers under the active check. Thanks to the

relevant mechanisms it is possible to quickly move from the infringement to the record

sheet/ driver card day on which an infringement took place. For each violation, you can view

and print the ready infringement template report.

In the final part of the report the Groups of infringements against Regulation (EC) No

561/2006 is presented.

How to create a report
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1. Open the report ("Reports" menu).

2. Analysis settings window is displayed, which should include:

· the analyzed period:

Ř All infringements and warnings – the software analyzes the period between the first

and the last step stored in the database for the specific control;

Ř period – allows setting any analysis period - by default, the software sets a controlled

period. For a roadside check – unless the to date is checked  - the period beyond

the check date will be analyzed.

· Use activities time tolerance:

 Option checked — tolerances of driving times, rest periods and breaks set in

the settings window, under: "Tolerance" tab will be taken into account during

the analysis of the infringements;

 Option unchecked — these tolerances are not taken into account in the

analysis of infringements;

· All drivers or Selected drivers - the program generates infringements for all

drivers or for the drivers who have been chosen from the list available after

clicking 

·  - press this button, the program will proceed to analyze

infringements in the pre-selected period of time - before you click, review the

settings described below;

·  - opens "Analysis settings" window;

 - click to expand the advanced settings panel.

Attach notes on violations - allows to attach notes that have been added to specific

infringements

Attach control notes - allows to attach general notes from the infringement tabs

Button:

Allows to set any dates in which the analysis is to be carried out in the Driver's

average weekly working time report - detailed report that is generated when you

click on the button.

Defining periods is necessary for analyzing infringements of weekly working time.
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If no periods are defined, generated infringements will not take into account weekly working

time infringements

Button:

Opens, for the selected driver(s), Driver's average weekly working time report -

detailed with specified periods (set using the  button) and

weeks, including: Driver, Period, Week, Weeks count, Driving time, Other work time ,

Actual working time of the driver and Norm. In the summary - the sum of weeks, the

sum of individual driving and work periods, and Average weekly working time

calculated during the period. If Average weekly working time is exceeded, it is

displayed in red.

Analysis according to

Select whether the data should be analyzed according to: AETR (2010) or Reg.

561.

Report on the basis of data from:

· cards / discs - control of driver’s card data and tacho disks;

· tachograph - control of vehicle data (mass memory data) – after choosing this

option the frame shown next becomes active:

Data from digital tachograph:

Select the type of analyzed events:

· activities with this driver's card inserted - only activities recorded in the

tachograph with driver card inserted;

· all activities from slot 1 - all activities recorded in slot No 1 of the tachograph

are verified, regardless of whether the driver’s card was inserted or not;

· all activities from slot 2 - all activities recorded in slot No 2 of the tachograph

are verified, regardless of whether the driver’s card was inserted or not;

do not consider lack of data in the beginning of the period as a rest

 Option checked 
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 Option unchecked 

analyse weekly rest starting from complete weeks (from Monday till Sunday)

the option is accessible only if the preceding one has been checked.

 Option checked 

 Option unchecked 
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Compare activities

The tab is only visible for control on the premises option (edit inspection window - "Control" -> "Edit

current control parameters" menu).

Depending on the settings, the tab lists the differences between the tachograph data

and the data downloaded from the driver card. In the comparison, you can also view the

data as recorded by the tachograph when the card was removed. The analysis is

performed during the report generation period.

Activity List

1. Like above, the activity list is generated by clicking on the:  button.

If the program detects:

· Activities recorded in the card that are not in any tachograph;

· Activities recorded in the tachograph that are not in any card;

Compare activities tab title will be bolded and will change color into red

(options available in the analysis settings: "Settings" -> "Analysis settings" menu,

"Analysis" tab).

2. Filtering results - above the table there are checkboxes for the driver, the

vehicle, and the "missing" type which allow to filter the analysis results.

3. From any entry in the list you can go to visualize the day with the "missing" items

("day from the driver card" or "day from the tachograph"). Double-click the left

mouse button on the selected line or select the line and select Edit the day from

the pull-down menu, or click on the button: ;

4. Activity Verification - To make work easier, each item in the list can be labeled as
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Verified -> Yes / No (first column) - right click on the selected line and select

Verified from the drop-down menu;

Actions All verified and All unverified are available in the drop-down menu.

Printing

 - opens a list print preview window of all items in

the list.

Infringements

Infringement list, edition, options

As a result of pressing the  button, if infringements have occurred in

the selected period of time, their list will be displayed in Infringements tab with

detailed data on each of them.

Danish version of the program

· the information about percentage of exceeding the standard will be displayed on the

descriptions of infringements;

· Max Rast / Summen af pauser column: depending on the infringement, the following will be

displayed:

· maximum resting time - in the case of too short daily resting time;

· the total time of breaks lasting at least 10 minutes - in the case of exceeding the continuous

driving time.

If the program detected irregularities associated with the use of the tachograph or the driver

card, the text under Manipulation warnings will be displayed in bold and change the color to red

(Description of the tab in the following topic.)

1. Results filtering - above the infringement table, there are driver, vehicle and

infringement type and severity selection boxes that allow to filter data in the list

of infringements.

2. Approval of the infringements - by default, all infringements detected by the
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program are approved. Status of the infringements can be changed using the

Approved, All approved and All not approved commands in the drop-down menu

(right-click on any item in the list of infringements). 

Unapproved infringements will have a "No" indication in the Infringement column.

Approved/unapproved infringements can be filtered using the Show approved infringements

only option below the list of infringements.

3. The most serious offenses are displayed in red, bold text;

· the most serious (MSI) and other violations (VSI, SI, MI) can be displayed

separately using filters (see item 1).

Regulation 1071/2009, Annex IV

Most serious infringements for the purposes of Article 6(2)(a)

1.

a) Exceeding the maximum 6-day or fortnightly driving time limits by margins of 25% or more.

b) Exceeding, during a daily working period, the maximum daily driving time limit by a margin of

50% or more without taking a break or without an uninterrupted rest period of at least 4,5 hours.

4. Under the infringement list, the overview of the infringement number according

to the level of seriousness is visible. The overview includes only approved

infringements.

5. Show approved infringements only - displays only items in the list with

Approved status in the Infringements column

6. On the basis of any violation shown on the list one can proceed to a day

visualization when the said violation was caused (see: Days from card or Discs).

In order to do this click the given violation with the mouse right button and

choose the option: Edit the day. 1. It is also possible . to go to the driver's Daily

chart window using 

7.  - opens "Weekly chart".

8.  - opens "Monthly chart".

If you want to add a description to the selected infringement, click CTRL+ E.

Printing
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1.  - when you press this button and select the language

of the report, the report preview window displays.

Depending on the option selected: Show not approved infringements in the report (striked

out) in the preview, unapproved infringements will not be displayed or will be shown as crossed

out.

Notes to an unapproved infringement will not be printed as crossed out.

Danish version of the program

· the information about percentage of exceeding the standard will be displayed on the

descriptions of infringements.

2.  - by clicking, the report is displayed: "Control report"

based on the settings selected in the window.

Manipulation warnings

List of manipulation warnings

1. Just as the list of infringements, the list of interference warnings is generated

when you press the button: . If the program detects irregularities

associated with the use of the tachograph or the driver card, the text under

Manipulation warnings will be displayed in bold and change the color to red.

2. Results filtering - above the interference warnings table, there are driver, vehicle

and warning type selection boxes that allow to filter data in the list of

interference warnings.

3. On the basis of any warnings shown in the list of interference warnings you can

go to visualize the day on which there was a warning (record sheet or driver card

day). To do this, click RMB on the desired warning and select Edit the day. You

can also select the specific warning and click on the following button:

.

4. For each of the selected warnings at the bottom of the tab, an instruction for

checks that should be performed to verify the warning will be displayed.

Printing
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1.  - opens a print preview window for the selected

warning along with the description.

2.  - opens the print preview window for the list of all

warnings found.

Annotation

Annotations can be entered for the entire inspection in general or specifically for

each item in the lists of infringements, manipulation warnings and activity comparisons.

Inspection annotations:

Available in the Infringements tab only.

· add/edit annotations - click on the , button located below

the infringements list;

· delete annotation - click on the  button, then clear the

contents of the window and click ;

Detailed annotations:

· add / edit annotations - right-click on the selected line and choose Add/edit

annotation from the drop-down menu;

· delete annotations - in the drop-down menu, select: Delete annotation;

Settings made in this window are stored for that control.

In the absence of data from the tachograph and if the limit of country entries on the driver card is used up,

the period beyond the limit is not taken into account when generating lack of the start/end country entry

infringements

Example
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Let's start a control of our driver, Jan.

From the Reports menu choose Infringements and manipulations.

You can also use the:  icon.

In the infringements generation window:

· check: All infringements and warnings;

· check: Use activities time tolerance;

· click the:  button;

Ř in the analysis settings window, click on the:  button;

Click: .
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The program displays a list of infringements and tamper warnings. By default, all

infringements have the status: Approved.

In the following items, examples of analysis of two suspected tampering cases are

discussed.

5.2.1. Use multiple driver cards

To show the case, data from the driver card of Radek Masar and data from the vehicle he

drove were retrieved.

Tampering of this type can be detected only on data downloaded from the digital tachograph.

In the Infringements and manipulations window, in Manipulation warnings tab, the

suspected tampering is represented as follows ("Use multiple driver cards" filter is applied):

In accordance with the instructions provided in the above window (in the example we

analyse only the first case):

1. Using card numbers, check in the TachoNet system for which person were the cards issued.

· go into the TachoNet system and perform verification.

2. Check the driving license numbers in the TachoNet system when issuing driver cards.
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· verify, as above.

3. Check when were both used driver cards issued or if the driver cards were used interchangeably.

· in TachoScan Control, in the same window, double-click on the warning;

· in the next window, the program opens Data from digital tachograph: in Card

insertions and withdrawals tab:

· card insertions and removals are sorted by date (fig. above) - on the basis of the

displayed results you can tell in a simple and fast way that the cards were used

interchangeably;

· in the same window, in the Activities on a specific day tab, the program uses the

exclamation marks "!" to display the places where tampering is suspected:
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· on the first (upper) data chart from the first slot in the tachograph, after highlighting

with the mouse, data of the inserted driver card can be read (bottom tab:Selection ->

Driver (slot 1)).

4. Check if the card with a higher number (e.g. ... 0110) was used earlier than the card with a lower

number (e.g. ...c0010). Such a situation is incorrect.

· in the former case, it was apparent that the cards were used interchangeably, i.e., the

condition was met: a card with a higher number was used earlier than the card with

the lower number.

If the TachoNet system confirms that the cards were issued to the same person we

have a clear case of tampering.

5.2.2. Driving without an appropriate card

For the purposes of this example, we retrieved data from the digital tachograph placed in

the vehicle: WSI 7X7X7.

If the control is carried out in the company, retrieving data from a specific driver card

depends on further analysis.
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As in the previous example, this type of tampering can be detected only for the data collected from a

digital tachograph.

In the Infringements and manipulations window, in Manipulation warnings tab, the

suspected tampering is represented as follows ("Driving without an appropriate card" filter is

applied):

In accordance with the instructions in this window:

1. Check if Article 16 of Regulation 3821/85 may be applicable.

· make verification.

2. Check if the appropriate printout or manual entries were made.

· for each driving event without the right card, we are looking for confirmation in the

manual records.

Subsequently, the control is dependent on manual records shown.

Using TachoScan Control, you can find the driver/drivers who drove the vehicle before

and after the events: Driving without an appropriate card. In our example, let's consider the

longest driving event: 1h 27min:

· double-click the mouse on the above warning;

· in the next window, the program opens Data from digital tachograph: in Activities

on a specific day tab:
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· exclamation mark "!" indicates the places where tampering is suspected (fig. above).

In our example, these are driving events without an appropriate card;

· the chart also shows that the driver card insertion event was recorded in the

tachograph, followed immediately by the regular driving activities (fig. below).

· highlight the place of card insertion with the mouse (fig. above) and in Selection tab

(located under the graphs) read driver details - in this case, Szczepan God;
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· then, we are looking for a driver who was driving the vehicle before the driving

without card events - scroll the chart back, until the place of driver card removal (fig.

below) appears;

· as above, highlight the place of card removal and read the driver details from the

Selection tab - it is also Szczepan God;

· there is a high probability that the driver drove the vehicle without a card - retrieve

data from his driver card;

· re-open the Data from digital tachograph: window, in Activities on a specific day

tab - compare the graph of the activities from the tachograph with the chart for

Szczepan God:
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If Comparison to data from driver card or disc chart is empty, uncheck current vehicle only and select

the appropriate driver.

· already in the first "driving without card" period (fig. above) you can see that

Szczepan God has no records besides manually entered stop - in the next days, the

situation is similar, until the place of card insertion;

· if necessary, you can copy the activities from the tachograph to the driver card - the

program offers such a possibility in the "view/ edit day from the driver card" window:

Ř click on the [Edit] button placed right of current vehicle only option;

Ř in the Driver's daily chart window, click on , to display the graph from slot no. 1 of

the tachograph, and then uncheck the editing blocked option (fig. below);

If the Vehicle field is empty, click on the  icon and then select the appropriate car.

Ř right-click on the activities from the tachograph graph and select Copy all activities from

the drop down menu (fig. below);
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· Copy all activities - (graph from the tachograph) - regardless of the selected function copies

(overwrites) all activities from the tachograph onto the driver card;

· Copy selected activities - (graph from the tachograph) - make the selection by left-clicking (area).

After selecting this option activities of the tachograph will be copied to the driver card within the

selection;

· Copy events from tachograph - slot 1 - (chart of the driver card) - the option is active only for card

withdrawn periods. It copies all events from slot no. 1 of the tachograph to the driver card. If you turn on

the chart from slot no. 2, Copy events from tachograph - slot 2 option is available.

· after copying activities, go to the: "Infringements and manipulations" report and

generate violations for Szczepan God again.

5.2.3. Compare driving time and distance on the map

Compare driving time and distance on the map opens the Google™ Maps window (online

map) or OpenStreetMap (offline map), where you can compare the kilometres read from the

tachograph and the driver card with the kilometres from the route calculated on the map.

The purpose of this analysis is to verify whether manipulations have taken place that

leave no trace in the tachograph or on the driver card. In practice, this is the only tool that

makes it possible to check whether the driver manipulated the tachograph using a magnet or

voltage reduction.

Online map (Google Maps)

When using the online map, you can perform the comparison based on GNSS locations or

based on a manually defined route.

If you use Google™ Maps, you can use both routing modes at the same time by switching between the

GNSS places and Route tabs (item 3).
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Comparison based on GNSS locations (GNSS places tab)

To perform a comparison based on GNSS locations:

1. Select the analysed period in the Date from and Date to fields, and select a vehicle or

a driver (default: Vehicle).

If you select the Driver option, the list displays only drivers who have a G2V1 or G2V2 driver card. The

map will show the route from the driver card without GNSS data imported from the digital tachograph.

2. In the Tolerance section, set the tolerance of the deviation between distance and time

values.

Enter an address or GPS coordinates to search for a

location. Click the date to change it.

3. Go to the GNSS places tab.

4. (Optional) Add your own GNSS

locations. Custom GNSS locations are

marked with the following icon: .

o To add a GNSS location, click Add a

GNSS point, then search for it from the

list (you can also enter GPS

coordinates).

o To change the date and time of your custom GNSS location (default: the content of

the Date from field), click the current value to open the date and time selection

window.

o To remove a GNSS location, click it on the list, then click Delete the selected GNSS

point.

5. (Optional) Select additional options from the Options dropdown list. 

Comparison based on a manually defined route (Route tab)

To perform a comparison based on a manually defined route:

1. Select the analysed period in the Date from and Date to fields, and select a vehicle or

a driver (default: Vehicle).

2. Go to the Route tab.

3. Select the starting point (A) and the end point (B).

Changing the order of route points.

o You can add more route points by

clicking Add destination.

o To remove a point, click x next to

that point.

o To change the order of route

points, place the mouse cursor
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over the letter of the point (A, B etc.). When the standard cursor changes to the

following: , hold the left mouse button and drag the point to the desired position

on the route.

4. (Optional) Select additional options from the Options dropdown list.

5. Click Show route in the map.

After each change in the route (e.g. removing a point, changing its order, etc.), click Show route in the

map again to apply the changes to the map.

The program will display the available routes. By default, the first route in the list is

displayed on the map. To change the displayed route, click it on the list.

Offline map (OpenStreetMap)

When using the offline map, you can perform the comparison only based on GNSS

locations.

1. Select the analysed vehicle or driver (default: Vehicle).

If you select the Driver option, the list displays only drivers who have a G2V1 or G2V2 driver card. The

map will show the route from the driver card without GNSS data imported from the digital tachograph.

2. (Optional) Change the analysed period in the Date from and Date to fields.

o By default, the Date from and Date to fields are automatically filled with the last day

of the controlled period.

3. In the Tolerance section, set the tolerance of the deviation between distance and time

values.

Exporting GNSS data to a GPX file

Location of the button for exporting GNSS data to a .GPX file.

You can export GNSS data to a .GPX file, e.g. to verify the route in another system. Only

the data according to the currently selected filters is exported.

To export GNSS data to a .GPX file, click the  button.

Route analysis
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In the Route analysis section, you will find the following information:

· (item 1) suggested travel time and distance calculated from Google™ Maps /

OpenStreetMap

§ number outside the parentheses – does not include the value from the ferry/train

field

§ number in parentheses – includes the value from the ferry/train field

· (item 2) suggested travel time and distance travelled by ferry/train calculated from

Google™ Maps / OpenStreetMap (editable)

· (item 3) suggested travel time and distance according to GNSS locations

§ number outside the parentheses – does not include the value from the ferry/train

field

§ number in parentheses – includes the value from the ferry/train field

· (item 4) suggested travel time and distance travelled by ferry/train according to GNSS

locations (editable)

· (item 5) tachograph data

· (item 6) driver card data

· (item 7) detected distance differences between tachograph data and GNSS data (see:

Compare driving time and distance on the map)

Comparison of tachograph and GNSS distances

When using the online map (Google™), the program automatically compares the distance

measured by the tachograph with the shortest road distance between the GNSS points.

When the distance measured by the tachograph is shorter than the road distance, an alert

appears: Found differences in km between GNSS and tachograph (see item 7 – fig. above). 

Printing the report

 – opens the report “print preview window”. After expanding the report printing

options [ ], you can choose the report For Google route or For GNSS points.

You can also use the Print Screenshot function (more information in the Help topic in the

Print Screenshot section).

Changing the map type (online/offline)

To change the displayed map type:

1. Go to Settings -> Program settings.
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2. Under the Web settings section, select Google Maps or OpenStreet maps (offline).

If you selected Google Maps or OpenStreetMap (offline), make sure that in the Web settings section,

the Google Maps / OpenStreetMap option is selected.

If you selected OpenStreetMap (offline), you must additionally download the map package (see:

Downloading offline maps).

The map selection applies to all users and inspections.

Downloading offline maps

1. Download the map package from:

https://maps:inelo@maps.inelo.pl/tsc7.2.3/tsc723osmeurope.zip.

o Package size: 34.4 GB.

2. Extract the contents of the package into the following folder: C:

\ProgramData\INELO\TachoScan Control\maps\.

o Package size after extraction: 42.7 GB.

The correct path to the sample files in the default program directory should look as follows:

C:\ProgramData\INELO\TachoScan Control\maps\osm-offline-dataPath\europe.pmtiles

C:\ProgramData\INELO\TachoScan Control\maps\graphhopper-cache\edgekv_keys

3. In the program settings select the OpenStreetMap (offline) option under the Web

settings section (see: Changing the map type (online/offline)).

If offline map files are not located in the folder indicated above, the map window in the

Compare driving time and distance on the map tab is filled with a grey colour (fig. below).

Make sure you unpacked the map files in the correct folder.

Symptom of missing offline map files or incorrectly unpacked map

package.

https://maps:inelo@maps.inelo.pl/tsc7.2.3/tsc723osmeurope.zip
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5.3. Presentation of infringements

The following are tools useful in the analysis of infringements:

"Weekly chart" - represents a seven-day chart of driver activities (data from record

sheets/ days from driver card) or a graph of activities from the digital tachograph. In the

chart, you can find all infringements (see the explanations is in the "Legend" tab). Driving

periods for each day and weekly rest periods are shown in a transparent manner;

"Monthly chart" - represents a five-week chart of driver activities. The graph clearly

shows the weekly rest periods and 2-week driving period;

"Control report" - in the report, Weekly chart is presented with a detailed description of

each week, which can be displayed in several languages. The report can be printed or

exported to PDF file. Control report is a sort of answer to what the infringements result from.

5.3.1. Weekly chart

Weekly chart is a graphic representation of driver's activities in specified weeks.

The chart may be accessed in the following ways:

· From the main Reports menu, select: Weekly chart;

· after pressing the  or  button in the preview windows of

the days from the "driver card" / "record sheet" and in the generation windows for

the following reports: "Control report" and "Infringements and manipulations";

Designation of the driver's activity is the same as in the "daily chart from the driver card".

To activate the report:

· specify driver's name (selected from the list);

or

· Vehicle;

Ř If in the downloaded reading the program finds activities stored on the first and the second

slot, the following selection options are displayed: Slot 1 and Slot 2;

For vehicles, only events are displayed - the program does not analyze any infringements.

· specify "time extent";

· press the button: .

The following options are available in the weekly chart:

Button:
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Opens in a new tab: "Monthly chart".

Selected activity

In the Selection tab on the left side of the chart, in Selected event field, the

information on the event pointed to with the mouse (fig. below) is displayed.

The time of inserting and removing the driver card will also be visible in the chart, if they were

downloaded from the tachograph card for the given day and for this vehicle.

After placing the cursor on the card insertion and removal symbol in the Selected activity

field, an appropriate bubble text will appear.

Fig. Point with the mouse to one of the driver activities on the chart.

Selected area

In the Selection tab, on the left side of the chart, in In the selected area field, a

summary of the selected period is displayed. Click with the mouse two points at the

weekly chart. Two lines will appear and mark the resp. period of time (item 1 and 2 - fig.

below).

Fig. Marking a part of the weekly chart.

You can grip those lines (marks) with the mouse and move them as you need (item 1

- fig. below). Having set the second mark you can make it jump to another position by

clicking another spot of the chart.
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If the selection area is larger than the chart displayed on the screen while selecting, or have other

problems, you can use when selecting an area from the drop-down menu.

Setting the start area - click the PPM to the desired location and drop-down menu, select Set

beginning

Settings for the end of the area - click the PPM to the desired location and drop-down menu,

select Set end.

There is the option Bind the selection line to events' edges below the chart. When this option is

activated the placed selection lines will be automatically moved exactly to the end/begin of the

neighboring activity (item 2 - fig. below).

Fig.3. Move selection line.

Overview and legend

In the third window: Overview, subsequent events from the weekly chart are totaled,

for the driver or the vehicle, respectively as well as OUT and AETR periods.

And in the fourth window Legend is shown.

Visualization of infringements (for driver only)

In addition to the linear visualization of events, the chart also shows the places where

infringements related to exceeding the driving time, working time or shortening the rest

time occurred.

Only confirmed violations will be displayed in the weekly chart.

The infringements analysis is carried out only for the selected driver.

The place of display is shown in the figure below (fig. below).
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Fig. Place, where the offences detected by the program are displayed.

Description of the other markings on the chart can be found in the Legend tab.

"Days" Tab

The Days tab shows the sums of four basic events (driving, work, driver's availability,

stop) for each day separately. 

View/edit days from the driver card/record sheet on weekly chart

From the weekly chart level it is possible to open the view/edit the day from the

driver card/record sheet (for a driver), or to open the day preview window from the

digital tachograph (for a vehicle) - from the weekly chart drop-down menu, choose: 

· Edit day

or

· double-click on the chart area for the selected day

The program will open a preview window for the selected day in a new tab.

Additional options

You can better evaluate particular parts of the chart by enlarging it with:  (button under the

chart). Use the button  to make the chart smaller. The default size of the chart can be regained

with .

Chart printout
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It is possible to print out the chart. After clicking LMB on the  button, a

pull-down menu will be displayed, with the following options:

· Print visible week - displays the print preview for the currently viewed week;

· Print selected weeks - displays the print preview for the currently marked

weeks (see "Selected area" above);

· Print entire period - displays print preview for weeks included in the control

period;

Options related with printing the chart:

· Show legend on the printout - if this option is marked, the legend will be

displayed on the last page of the report;

· Show activities list on the printout - after marking this option, a list of actions

included in the chart will be displayed under the weekly chart, right above the

legend;

5.3.2. Monthly chart

There are 5 consecutive weeks displayed in the monthly chart which provides easier and

faster analysis of weekly rests, weekly driving time and fortnightly driving time.

The chart may be accessed in the following ways: 

· from the main Reports menu, select: Monthly chart;

· after pressing the  or  button in the "weekly chart"

window and the generation windows for the following reports: "Control report" and

"Infringements and manipulations".

To activate the report:

· specify driver's name (selected from the list);

· specify time extent,

· press the button: ;

The main features of the monthly chart

1. One week displayed in one line.

2. The whole chart view covers 5 weeks (we can see the whole period of 28 days).

3. An option that enables the display of rest periods only is available:

· you can select the length of rest periods to be shown in the chart (daily and

weekly rest periods are displayed by default);

4. Display of 24/30 hour periods.

5. Display of a 6-day period for taking a weekly rest.



77

Data verification

6. Day/weekly rests are drawn differently than in the weekly chart (see the legend).

7. Options/mechanisms taken from the weekly chart:

· the option of marking any area (dragging the marking to the event edge);

· displaying the data of a backlit event using the mouse;

· visualization of the offenses;

Chart printout

You can print the chart. When you left-click on the  button, a drop-down

menu appears with the following options:

· Print actual view - opens currently displayed month printout preview;

· Print selected period - opens currently selected period printout preview (see

topic: "Weekly chart -> Selected area");

· Print entire period - opens printout preview of all the weeks in the controlled

range;

Options related to chart printout:

Ř Show legend on the printout - if this option is checked, then the chart legend will be

appended to the printout;

Ř Show activities list on the printout - if this option is checked, then all the driver's

activities in the printed period will be listed in the printout (right before the legend).

Switching to the daily chart

1. Right-click on the activity on the selected day.

2. Select Edit the day from the drop-down menu.

OR

1. Double-click on the activity on the selected day

5.3.3. Control report

This report is helpful in understanding the analysis of driving time, time of daily and

weekly rest periods and to understand and explain any infringements detected by the

program. The report can be called either from the menu: Reports -> Control report as well as

from the infringements report generation window: "Infringements and manipulations" when

you press the button: .

Report construction

· weekly chart of record sheets activities/ driver card days (key on the last page of

the report);
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· weekly and two-week driving time (for the current and the previous week) with

comments on possible cases of exceeding the norms and driving time available

next week;

· information on weekly rest periods: the time the rest was used and its duration,

possible reduction and compensation, then the number of days between the

previous and the current weekly rest period;

· information on daily rest periods: for each day the maximum time of rest and the

time of daily rest used are shown. In addition, comments on these times are

entered, stating the compliance with Council Regulation (EEC) No 3820/85 or

Regulation (EC) No 561. The division into the days is done according to the

provisions of the laws;

· daily driving periods: the length of the cycle (daily driving period), the analysis of

daily driving time and constant driving time, comments on possible exceeding

the norms. The last column shows the penalty amount for the driver and the

company according to the fines for infringements;

· on the last page there is the key for the signs used in weekly activities chart.

How to create a report

1. Open the report generation window (menu: Reports -> Control report or menu:

Infringements and manipulations -> ).

2. Select a driver from the Driver menu.

3. Set the analysis period in the fields Period from and To.

4. In the Analysis according to section, choose analysis according to AETR (2010) or

561 (Regulation (EC) No 561/2006 of the European Parliament and Council).

5. In the Report on the basis of data from: section, select:

o cards / discs - control of data downloaded from driver cards and recorded

tachograph discs.

o tachograph using activities assigned to particular drivers -  control of data

downloaded from digital tachographs.

6. Click  (Generate) or  (Generate and close).

7. Choose the report language and click OK.

Infringements committed outside the period of employment of the driver or outside the scope of control are marked

.

Options

For a detailed description of other options refer to: "Infringements and manipulations"
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Data verification

->  tab.

show weekly chart on the report

After selecting this option, the so-called weekly chart of driver’s driving time will

be shown at the end of each week section,

(markings of symbols on the chart is the same as on the "weekly visualization").

Colour

As a result of selecting this option, some elements of the report will be presented

in several basic colors, otherwise it will be presented in shades of gray.

Legend

After selecting this option, a legend for the weekly chart will be presented in the

final section of the report.

Display amount of fines (only in Danish and Romanian language versions)

 Option checked — unapproved amount of fines will be shown according to

tariffs of penalties applicable in Denmark/Romania ;

 Option unchecked — unapproved amount of fines will not be displayed;

Button:

Opens "Weekly chart".

Button:

Opens "Monthly chart".

To view the report, use the toolbar buttons (see: Generating reports).
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Locking and exporting of control

6. Locking and exporting of control

After approval and printing out is done, or after copying of reports is finished, we may set

about the locking of control. Control locking is necessary for it to be exported.

In order to lock control we press the second icon: .

TachoScan displays a window confirming control closing and then a control summary

window:

Control exporting

Once they are complete and locked, controls may be exported for archiving purposes.

With this purpose in mind, from the Control menu we opt for Export selected controls.

It is also possible to opt for control exporting from the Controls menu window.

By default, the TachoScan software exports selected controls to the directory: "C:

\Documents and Settings\UserName\My documents\Controls\Export".

If we want select another directory for saving exported control, then, we use the Set

directories option from the TachoScan menu.
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Locking and exporting of control

One may also set the export directory from Controls menu window.

After command is triggered, Program settings window shall be displayed, where we

may enter in any other location of choice, or with the use of the  icon, choose another

directory.

After exporting if finished, the TachoScan Control software shall save the file in a

stated directory with a name containing a given number of control with *.zip extension.

This file shall contain all of the data from the performed control.

7. Unlocking and editing of control

In order to view or edit a given already performed control (in the archiving module it may

be an imported control), from the Control menu one should select the command: Edit/view

selected control.
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Unlocking and editing of control

Alternatively, we may use relevant option from Controls menu.

After making our choice, Select control window shall be displayed. We mark, then, a

given required control and press .

If the control is locked, then, we unlock it SOLELY for previewing – data editing is not possible, here.

In order to narrow down a given number of controls being displayed on the list, expanded

filtering system to the right of the window may be used.

Edit control data

In the Control menu, select: Edit current control parameters:

The following window shall appear:



83

Unlocking and editing of control

When the "controlled period" is changed, it is necessary to download the data from driver's card

and/or digital tachometer again and then to reanalyze the drivers' infringements.
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Unlocking and editing of control

Edition of closed control

In order to begin editing a locked control, from Control menu we opt for the command

Edit/view selected control, and then, we right-click with the mouse on the selected

control and opt for Unlock and edit the control (fig. below).

After generating Infringements and manipulations report, you can change the status

of infringements.

8. Generating reports

A report can be generated in two ways:

Rys. Pasek narzędziowy okna

wywołania raportu.

·  - (fig. above) - Generate and close - when the report is displayed, the window

from which the report was generates will be closed;

·  - Generate - when the report is displayed, the window from which the report

was generates will still be visible,

This option is recommended when displaying several reports of the same type – then, there is no need to

close the report preview window to display the same report, for example, for another driver or period.
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